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Introduction (Lines)

Beginning a New Drawing

• Start AutoCAD 2000 by using either the Start menu 
or the shortcut icon on the desktop

• The startup screen presents the user with a number 
of options:

(a) Open an existing drawing 
(b) Start a new drawing from scratch
(c) Use a drawing template
(d) Use a Drawing Wizard (guides you through setup)
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Introduction (Lines)

The Drawing Window

• The menus and options displayed on the drawing 
window screen can be modified, depending upon 

• the type of drawing being modified
• personal preference

• Options are switched on and off manually via the 
mouse and function keys, and automatically by the 
program (context sensitive)

• Open a text window using the F2 function key. Moving 
between open text and drawing windows is done by 
selecting the appropriate button on the task bar 
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Introduction (Lines)

AutoCAD Basics

• The two button mouse is the most common 
AutoCAD pointing device

• Left button is used for point selection, object selection, 
and menu or tool selection.  Called pickbutton

• Right button functions as an alternative to the 
keyboard enter key, or calls pop up menus or help 
windows (depends on the situation)

• Moving the mouse changes the position of the screen 
cursor

• Screen Cursors
• Cross hairs: two perpendicular lines whose 

intersection marks the current point
• Pick box: small box at the intersection of the cross 

hairs; used to select objects for editing
• The cursor becomes an arrow (used to select menus, 

tools, and task bars) when you leave the drawing area
• Scroll Bars

• Allows drawings too large to fit on the screen to be 
displayed

• Position of the drawing changes relative to the screen 
but not relative to the UCS coordinate system
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Introduction (Lines)

AutoCAD Basics (continued)

• The coordinate display
• Located at the bottom left side of the status line
• Keeps track of where the cross hairs are located
• Measures the location of the cursor with respect to the 

drawing origin (0,0,0) (demarcated by the UCS icon)
• Pressing F6 puts the coordinate display into static mode, 

where the coordinate display only changes when a new 
point is chosen with the mouse

• Grid
• Matrix of dots which provide points of reference 
• Gridpoints are not printed as part of a drawing
• Pressing F7 or double clicking on the word GRID on the 

status bar toggles the gridpoints on and off

Cursor

Origin/UCS icon

Coordinate Display

Gridpoints

GRID switch
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Introduction (Lines)

AutoCAD Basics (continued)

• Snap
• Prevents point selection at any location which is not 

on a gridpoint (or a specific point on an object)
• Allows for a degree of accuracy which is not otherwise 

possible
• Gridpoints and snap can be set at any distance; 

default setting is 0.5000 inches
• Snap is toggled by using the F9 function key, or by 

double clicking on the word SNAP on the status bar
• UCS icon

• Indicates the direction of the X and Y coordinates
• Can be turned off through the use of the ucsicon

command
• Type ucsicon
• Type off at the prompt
• Can be turned on using the same command

• Undo and Redo
• Undo commands by typing U at the command line, or 

by using the Undo toolbar button
• Redo any undone commands by typing R at the 

command line, or by using the Redo toolbar button
• Cancel any in-progress command by hitting the Esc

(escape) key
• Repeat any command by hitting enter key or space bar

at the command prompt



Dix and Riley:  Introduction to AutoCAD 2000 7

Introduction (Lines)

Command Entry Methods

• The same command can often be executed by 
either typing a key word, or by selecting items from 
a toolbar, a pull down menu, or a tablet menu

• No one method is preferable to any other; AutoCAD 
users develop their own preferences as they work

• Keyboard/Command Line
• Most primitive and fundamental way of entering 

commands
• Commands are typed on the command line at the 

bottom of the screen and ended by pressing enter
• Has changed little since early versions of the program
• Some common commands are abbreviated by one or 

two letter aliases

Alias   Command  
A ARC 
C CIRCLE 
E ERASE 
F FILLET 
L LINE 
M MOVE 
O OFFSET 
P PAN 
R REDRAW 
S STRETCH 
Z ZOOM 
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Introduction (Lines)

Command Entry Methods (continued)

• Pull Down Menus
• Work as they do in any Windows 95/98 application
• Items followed by a triangle have “cascading” 

submenus (a)
• Picking an item that is followed by an ellipsis (. . .) will 

call up a dialog box (b)

• Toolbars
• Comprised of buttons (icons) that give one-click 

access to commands (c)
• Seventeen toolbars are available; to avoid clutter, do 

not open more than are necessary
• Toolbar icon labels (“tooltips”) are shown by simply 

pointing to an icon without clicking (d)

(a)

(b)

(c)

(d)
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Introduction (Lines)

Drawing Lines

• Choose a method for entering the Line command
• Type “L” at the command prompt (and hit enter)
• Select the Line icon from the Draw toolbar
• Select Line from the Draw pull down menu

• AutoCAD will say, “Specify first point:” Choose the 
initial point of the line by either…

• Typing in the coordinates of a point and hitting enter
• Moving the on-screen cursor with your mouse, and 

selecting the appropriate point by left clicking
• AutoCAD will say, “Specify next point or [Undo]:”

Choose the second point in the same way you chose 
your first

• AutoCAD will continue to say, “Specify next point or 
[Undo]:” until Enter or the right mouse button is pushed.  
This will terminate the line command

• Some tips for entering lines:
• A rubber band extends from the line start point to the 

position of the cursor on the screen.  This indicates that 
AutoCAD expects you to provide an endpoint

• Press F6 to turn on the coordinate display, or to switch 
between absolute and polar coordinates

• The space bar can be used in place of enter to terminate a 
command

• Use Ortho mode (hit F8 button, or double click on the word 
ORTHO) to force the pointing device to pick up points only 
along the horizontal and vertical quadrant lines from a 
given starting point



Dix and Riley:  Introduction to AutoCAD 2000 10

Introduction (Lines)

Polar Tracking

• New to AutoCAD with this version
• Can be used in place of ORTHO mode
• To turn on, either press the F10 button on the 

keyboard, or the POLAR button located on the 
Status Bar

• Polar Tracking and ORTHO mode are mutually 
exclusive

• In polar tracking, when a rubber band crosses a 
horizontal or vertical axis (i.e., when the rubber 
band is at 0, 90, 180, or 270 degrees), a dotted line 
appears that extends from the line origin to the end 
of the drawing area

• Polar tracking defaults to the orthogonal angles, but 
can be set to track at any angle

Line origin (point 1)

Tool tip

Cursor
Reports cursor 

displacement from 
origin; current angle

Rubber band
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Introduction (Lines)

Saving and Opening Drawings

• Saving drawings
• Invoke the save command either from the pull down 

menu, the toolbar, or by typing on the command line
• SAVE saves an already named drawing under its current 

name.  The current version of the drawing writes over the 
previous version

• SAVEAS allows you to
• Choose a name for your drawing file
• Save a named drawing under a new name
• Save as a file type other than AutoCAD 2000 (a)

• All saved drawings will have a .dwg extension added to 
their names to identify them as AutoCAD files (b)

• Use the OPEN command to access previously saved 
drawings

• Only .dwg files are displayed unless another file type is 
chosen in the dialog box

• Files saved in another location can be accessed by 
changing directories (c)

(a)

(b)

(c)
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Circles and Drawing Aids

Grid and Snap

• Gridpoints can be toggled on and off by either 
• Pressing F7
• Clicking on the word GRID in the status bar

• Snap can be toggled on and off by either
• Pressing F9
• Clicking on the word SNAP in the status bar

• Grid and snap parameters are easily changed via 
the Drafting Settings Dialog Box

• Select Tools, then Drafting Settings from the pull down 
menu, or type ds at the command line to obtain the 
dialog box

• Note that grid and snap spacing are not required to be 
the same
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Circles and Drawing Aids

Units

• Units determine how coordinates and dimensions will 
be reported

• Access the UNITS dialog box by either typing UNITS
on the command line or choosing Units… from the 
Format drop down menu

• The dialog box allows unit formats (above) and number of 
significant digits (precision) to be specified

• Units options are changed via the pop-down lists in the 
dialog box

Unit Type  Example 
Scientific 1.55E + 01 
Decimal 15.50 
Engineering 1’-3.50” 
Architectural 1’-3 ½” 
Fractional 15 ½  

 

 

Access pop-down 
menus by clicking
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Circles and Drawing Aids

Drawing Circles

• Access circles via the pull down menu, the toolbar 
button, or by typing the keyword C on the command 
line

• Circle dimensions are specified by giving AutoCAD 
one of the following:

• Three points on the circle’s circumference
• The endpoints of the diameter
• Two tangent lines and the length of the radius
• The center point and the length of the radius
• The center point and the length of the diameter

• Dimensions and point locations can be specified by 
typing in values, or by using the cursor and clicking 
with the mouse

AutoCAD Help

• Access help from the pull down menu, the toolbar 
button, typing F1, or by typing help on the command 
line 

• If you access Help while in the middle of a 
command, you will get context sensitive assistance

• The Help function in AutoCAD works similarly to 
Help in most Windows 95/98 programs
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Circles and Drawing Aids

Erase and OOPS

• Erase
• Allows you to remove unwanted objects from your 

drawing
• Type e on the command line, select Erase from the 

Modify pull down menu, or select the Erase button 
from the Modify toolbar

• OOPS
• Oops is to erase as redo is to undo
• Oops redraws the last object (or set of objects) that 

was erased
• Only the most recent set of erased objects can be 

restored via oops

Command Sequence Order

• Verb/Noun: Choose the action first, then pick the 
objects.  This is the “default” setting for AutoCAD

• Noun/Verb: Choose the objects first, then specify 
which action is to be taken
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Circles and Drawing Aids

Selection Methods

• Objects (entities) are generally picked by using the 
cursor and pointing device

• There are many selection methods
• Picking

• Use the cursor to point to the desired object, and left 
click with the mouse

• Selected object (a) will change from solid to dashed

• Windowing
• Click on any point not on an object (b)
• AutoCAD will ask for a second point
• Click on any other point, to form a box (c)
• All objects inside the box are selected (d)

(a)

(b)

(c)
(d)
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Circles and Drawing Aids

Other Selection Methods

• Crossing: Entities within or crossed by the box are 
selected

• Previous: Entities that were previously picked are 
(again) selected

• Last: The entity that was drawn most recently (last) 
is picked

• Remove: Deselects objects one at a time from a 
group of selected entities

• Add: Adds objects to the group of entities already 
selected

• All: Selects all entities currently visible on the 
drawing

• Fence: Selects all objects crossed by a selection 
line (fence)

• Wpolygon: Selects all objects within a selection 
polygon

• Cpolygon: Selects all objects crossed or within a 
selection polygon
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Layers, Colors, and Linetypes

Layers

• Allow specialized groups of entities to be treated 
individually

• Individual layers can be “turned off” to render 
objects in that layer invisible.  This reduces clutter, 
and allows specific details to be printed individually

• Objects in layers that have been turned off are still 
part of the drawing database

• Different line types and/or colors are often put on 
their own layers (e.g. dimensions, hidden lines)

• Use of layers is up to the AutoCAD designer
• Their use is only for convenience
• The final drawing will look the same regardless of 

whether layers were used
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Layers, Colors, and Linetypes

Layer Properties Manager

• Activate layer properties manager from the Object 
Properties toolbar or from the Format pull-down menu 

• Layers are initially defined by number, and can be 
given unique names

• Define a new layer by clicking on 
• Linetype, lineweight, and color can be set for each layer 

that has been defined 
• Quickly switch among layers by clicking on the current 

layer list box found on the Object Properties toolbar
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Layers, Colors and Linetypes

Fillets and Chamfers

• Fillet  
• A rounded corner between two lines
• Generally replaces a 90o angle
• Start command by either

• Typing f on the command line
• Selecting the Fillet tool from the Modify toolbar
• Choosing Modify, Fillet from the menu bar

• Fillet radius (degree of rounding) can be changed by 
typing R at the fillet command prompt

• Chamfer
• A beveled edge used to replace a square (90o) angle
• May be either symmetrical (a) or asymmetrical (b)
• Start command by either

• Typing cha on the command line
• Choosing Modify, Chamfer from the menu bar
• Selecting the Chamfer tool from the Modify toolbar

a b
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Layers, Colors and Linetypes

Zooming and Panning

• Zoom: allows you to control the magnification of the 
objects on the screen

• More magnification means less workspace visible
• Less magnification allows a wider view
• Invoke zoom command by either typing z on the 

command line or selecting one of the Zoom tools from 
the Standard toolbar

• At the zoom prompt (obtained using the z command):
• Type a (zoom all) to bring entire drawing into view
• Type p (zoom previous) to return to the previous 

scale
• Type w (zoom window) to define a view by specifying 

two points at the window corners.  Specified view will 
fill available screen space

• Panning
• Allows you to shift the area you are viewing in any 

direction
• Similar to using window scrollbars
• Does not change the view magnification
• Invoke pan command by either typing p on the 

command line or selecting Pan tool from the Standard
toolbar

• When pan cursor (hand) is visible, drag drawing to a 
new position by moving the mouse while holding down 
its left button



Dix and Riley:  Introduction to AutoCAD 2000 22

Template Drawings

• Model Space
• Space in which objects are created and edited
• Objects in model space are always drawn full scale:   

1 screen unit = 1 unit of length in the real world
• Paper Space

• Screen units represent units of length on a piece of drawing 
paper

• Considered mostly when plotting multiple views of a 3D 
drawings

• Limits
• Usually correspond to the size of the paper used
• When limits are on, entities cannot be added to a drawing 

outside of the predetermined area 
• May be specified…

• by typing limits on the command line
• by choosing Format, Drawing Limits from the menu bar
• when creating a new drawing by choosing the Advanced 

Wizard option in the Create New Drawing dialog box

• Limits are visually indicated in a drawing by the extent of the 
grid

Limits are typed into the 
Area portion of the 
Advanced Setup 
Wizard dialog box.  
Units and angle 
parameters can be 
specified on the 
preceding Wizard 
screens
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Template Drawings

Creating a Template File

• A template is a special file that contains the 
AutoCAD settings you wish to use for your drawing

• Settings for the following may be contained in a 
template file: Grid, Snap, Units, Limits, Layers, 
Colors and Linetypes 

• Generally, template files will contain only settings.  
No objects should be drawn on your screen when 
creating a blank template file

• Saving a template
• Choose File, Save As… from the menu bar
• Choose Drawing Template File (*.dwt) from the Save 

as type dialog
• Your template file will automatically be saved in 

AutoCAD’s template folder
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Template Drawings

• Move Command
• Changes the location of an object on a drawing
• Invoke by typing m on the command line, selecting 

Move from the Modify menu or selecting the Move tool 
from the Modify toolbar

• Select the object to be moved
• Select a base point and a displacement point, which 

together define the vector that indicates the distance 
and direction of the object’s movement

• Copy Command
• Copies an object to another location while leaving the 

original intact
• Invoke by typing co on the command line, selecting 

Copy from the Modify menu, or selecting the Copy tool 
from the Modify toolbar

• Select the object to be copied
• Select a base point and a displacement point to 

indicate the location of the duplicate 
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Template Drawings

• Multiple Copies
• Similar to the basic copy procedure
• After selecting the object to be copied, type m (for 

multiple option) on the copy command line
• Indicate a base point and displacement point for the 

first copy
• AutoCAD will prompt you for additional displacement 

points that indicate the vector from the original base 
point to each new copy

• Hit enter to exit the multiple copy command

• Rectangular Arrays
• Arranges copies of a figure in a rectangular array
• Powerful alternative to simple copying
• Invoke by typing ar on the command line, selecting 

Array from the Modify menu, or selecting the Array
tool from the Modify toolbar

• Select the object to be copied
• Type r to indicate rectangular array
• AutoCAD will prompt for number of rows, number of 

columns, distance between rows, and distance 
between columns.  The array is built up and to the 
right from the original object

Original object
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Arcs and Polar Arrays

Polar Arrays

• Arranges copies of a figure in an arc
• Powerful alternative to simple copying
• Procedure:

• Type ar on the command line, select Array from the 
Modify menu, or select the Array tool from the Modify
toolbar

• Select the object to be copied
• Type p to indicate polar array
• Click to specify the center point of the array
• Specify number of items in the array
• Specify angle to fill

• Can be as large as 360o

• positive angle = clockwise; negative angle = counter-
clockwise

• Indicate yes (y) if items are to be rotated as they are 
copied

The objects in this array 
were rotated as they 
were coped

Center point of array 

Original object
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Arcs and Polar Arrays

Arcs

• AutoCAD provides at least eight different methods 
for drawing arcs

• Each method requires the same basic information:  
a start point, an end point, and information about 
what circle the arc is part of

• Simplest method:  The 3-points option (default)
• Type a on the command line, or select the Arc tool 

from the Draw toolbar

• Select points 1 and 2, the starting point, and a point on 
the arc

• Point 3 is the arc endpoint.  As you move your cursor, 
AutoCAD displays an arc that corresponds to the 
current location of point 3

• Other methods include specifying start point, circle 
center, and end point; start point, circle center, and 
angle of sweep; and start point, circle center, and 
end point of the arc.  These and others are shown in 
Figure 5.5 of the text
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Arcs and Polar Arrays

Rotate

• Used to rotate objects after they have been drawn
• It is often easier to draw an object in a vertical or horizontal

position, and then use the rotate command to move it to a 
diagonal position

• To access the Rotate command: 
• Select an object to be rotated
• Type ro on the command line, select Rotate from the Modify 

menu, or choose the Rotate tool from the Modify toolbar 

• Base Point  
• The point about which the object is rotated
• The base point can be located anywhere on the object, and 

can be located on the object itself
• Angle of rotation

• Positive angle provides a counter clockwise rotation
• Generally specified with respect to 0o

• Typing r after specifying the base point allows the rotation 
angle to be specified with respect to an angle other than 0o

Base point

Original object

This figure was generated 
by repeating the rotate 
command three times
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Arcs and Polar Arrays

Mirror Images

• All points on an original object are reflected across a 
mirror line at an equal distance and opposite 
orientation

• Original object can be retained, or deleted from the 
drawing

• To access the Mirror command: 
• Select an object to be reflected
• Type mi on the command line, select Mirror from the 

Draw menu, or choose the Mirror tool from the Modify
toolbar 

• Choose the endpoints of the mirror line
• Retain or delete the original object, when prompted 

Original arc

Mirror line (not visible in 
finished drawing)
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Object Snap

Selecting Points with Object Snap

• Snaps cursor to a specified point on a previously 
drawn object

• Overrides grid (coordinate system) snap function
• Increases accuracy of drawing where lines are to 

meet at one specific point
• Drawing an object using Object Snap Mode:

• When AutoCAD asks for a point, turn on object snap 
mode by choosing a command from the pop-up 
shortcut menu (hold down shift or control key and 
right-click with the mouse)

• Once a snap mode has been chosen, move the cursor 
near the desired snap point.  When the snap marker
indicates that AutoCAD recognizes an appropriate 
point, left-click to pick the point

• Subsequent points can be picked using snap mode by 
repeatedly accessing the cursor menu

• Specific object snap modes can also 
be chosen via the object snap 
toolbar (right-click on any toolbar 
and choose object snap from the 
pop-up menu)
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Object Snap

Running Object Snap Mode

• Allows all points to be chosen using object snap 
mode

• Type os on the command line, or choose Object 
Snap Settings from the pop-up shortcut menu
described previously

• Check boxes toggle various object snap (osnap) 
modes on and off
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Object Snap

Description of Object Snap Modes
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Object Snap

Description of Object Snap Modes (continued)
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Object Snap

Object Snap Tracking

• New AutoCAD 2000 feature
• Creates temporary construction lines from 

designated object snap points to the edge of the 
display

• Similar to polar tracking
• Construction lines can be drawn along orthogonal 

axes, or along polar tracking angles, through acquired 
points to the edge of the display

• By acquiring more than one point, AutoCAD can 
exactly locate points that could not be easily found 
any other way 

• Example: a point whose vertical coordinate 
corresponds to the tangent point between a line and 
a circle

1:  Initial point 
specified in draw
command

2: Point acquired at 
corner of square

3: Point acquired 
tangent to circle

4: Point of interest at 
intersection of 
construction lines
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Object Snap

Object Offset

• Allows objects to be duplicated at specific distances 
away from the original.  The new object is typically 
drawn parallel to the first

• Invoked by either selecting Offset from the Modify 
menu, or choosing the Offset tool from the Modify
toolbar

• Offset distances can be specified using points found 
via the object snap tracking method
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Object Snap

• Break
• Allows a line to broken into two or more distinct 

entities
• Allows unwanted sections of a line to be removed

• Invoke Break by either
• Typing break on the AutoCAD command line
• Selecting Break from the Modify drop down menu
• Selecting the Break tool from the Modify toolbar

• After the break command has been selected, the 
line will be broken into two entities defined by the 
position of the point used to select the line

• The position of the second point will determine 
which part of the line is deleted (4 cases shown)

Entity 2Entity 1 Selection point

Point 1

Point 2
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Object Snap

• Trim
• Allows objects to be shortened at their point of 

intersection with other objects
• Works with lines, circles, arcs and polylines

• Invoke Trim by either
• Typing tr on the AutoCAD command line
• Selecting Trim from the Modify drop down menu
• Selecting the Trim tool from the Modify toolbar

• After the trim command has been selected, choose 
objects which will serve as cutting edges

• Once all cutting edges have been selected, hit Enter
to begin trimming objects

• Click on the object to be trimmed on either side of a 
cutting edge

• Portion of the object which is located on the side of 
the cutting edge chosen will disappear:

Cutting Edge
Choosing at A will cause portion of line 
on outside left of circle to disappear

Choosing at B will cause portion of line 
inside circle to disappear

Choosing at C will cause portion of line 
on outside right of circle to disappear

A CB
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Object Snap

• Extend
• Allows objects to be extended to an existing (or 

temporary) object or line
• Similar in behavior to the trim command

• Invoke Extend by either
• Typing ex on the AutoCAD command line
• Selecting Extend from the Modify drop down menu
• Selecting the Extend tool from the Modify toolbar

• After the extend command has been selected, 
choose objects which will serve as boundary objects

• Once all boundary objects have been selected… 
• Hit Enter to begin choosing objects to extend
• Choose a point on the object to be extended that is 

closest to the boundary object

Points selected on original object

Extended Lines

Boundary Line
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Text

• AutoCAD 2000 has two commands which allow the 
addition of text to a drawing:

• DTEXT
• Allows single lines of text to be entered
• Shows the text on the screen as it is entered
• Allows backspacing through text to correct errors

• MTEXT
• Allows you to type paragraphs of text in a dialog box
• Window containing text is then positioned on the 

drawing
• Invoke DTEXT by either

• Typing dt on the command line
• Selecting Text, Single Line Text from the Draw menu
• (Text tool on the Draw toolbar invokes MTEXT, not 

DTEXT)
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Text

Using DTEXT

• Justification options: specified by entering J at the 
DTEXT command prompt, and then entering the 
type abbreviation:

• You must specify text insertion point, height, and 
angle when prompted to by the DTEXT command

Examples above shown 
with respect to a horizontal 
line; examples to the left 
shown with respect to text 
insertion point.
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Text

Editing Text

• DDEDIT: Allows text to be edited in place on an 
AutoCAD drawing

• Invoke DDEDIT by either
• Typing ddedit on the command line
• Selecting Text from the Modify menu
• Selecting the Edit Text tool from the Modify II toolbar

• At the DDEDIT (select) prompt:
• Choose a line of text (or other text object) to edit by 

clicking on it
• Make appropriate changes in the dialog box that 

appears
• Click OK button to make the changes

• SPELL: Checks the spelling of all text objects
• Invoke SPELL by either

• Typing spell on the command line
• Selecting Spelling from the Tools menu

• Select text to check by left clicking with the mouse, or 
type all to check every text object

• Either Change or Ignore the suggested changes 
AutoCAD makes each time it notes an unrecognized 
word
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Text

Fonts and Styles

• Font 
• Basic symbol or character shape used with DTEXT 

and MTEXT commands
• Many to choose from, but difficult to create your own
• Default font: txt

• Style
• Refers to the size, orientation, and spacing of 

characters as they are typed in any specific font
• STANDARD style is the default, but variations can be 

created by the user
• Invoke Style command by either

• Typing st on the command line
• Selecting Text Style from the Format menu

• Text Style Dialog Box
• Allows previously defined styles to be selected
• Allows new text styles to be created and stored for 

future use 
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Text

Changing Object Properties with MATCHPROP

• Allows some or all properties of one object to be 
changed (matched) to those of another

• Properties that can be transferred between objects 
include: layer, linetype, color, thickness, text style, 
dimension style, etc.

• Invoke MATCHPROP by either
• Typing matchprop on the command line
• Selecting the Match Properties tool from the Standard 

Toolbar

• Source object: Object whose properties will be 
exported to destination object(s)

• Limit properties to be matched by typing s at the 
prompt.  Property Settings dialog box will then appear

• Choose destination objects (by left clicking) to 
complete the command
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Text

Scaling Previously Drawn Entities

• SCALE allows the size of previously-drawn entities 
to be changed

• Invoke Scale command by either
• Typing sc on the command line
• Selecting Scale from the Modify menu
• Choosing the Scale tool from the Modify toolbar

• Choose objects to scale by pointing or windowing
• The base point refers to the first point of a line that 

determines the scale factor.  
• If the line length specified is less than 1, the selected 

objects will decrease in size
• If the line length specified is greater than 1, the 

selected objects will increase in size
• Location of the base point determines the location of 

the scaled object
• Scale factors can be entered by using the reference 

(r) option
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Dimensions

Dimension Style

• Set of variable settings that controls the text style 
and geometry of AutoCAD dimensions

• Dimension style should be created before 
dimensioning any AutoCAD objects

• Dimension style can be saved as part of the drawing 
template

• Dimension Style Manager Box: Allows dimension 
style to be set, created and previewed

• Access Dimension Style Manager Box by either
• Typing d on the command line
• Selecting Dimension style from the Format menu
• Selecting Style from the Dimension menu
• Selecting the Dimension Style tool from the Dimension

toolbar
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Dimensions

Creating a New Dimension Style

• Click on New button in Dimension Style Manager
• Specify name of new style, dimensions types (linear, 

angular, etc.) the new style should be used for, and 
“starting point” for new style, as shown

• Details of new dimension style are specified on the  
tabbed pages of the dialog box shown below
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Dimensions

Dimension Types

• Linear dimensions: use dimlinear command

• Baseline format (multiple linear dimensions measured from 
the same origin): use dimbaseline command

• Continued format (a string of chained linear dimensions): 
use dimcontinue command

• QDIM: New AutoCAD 2000 command that automates the 
creation of of certain types of multiple dimension formats

Continued dimension

Baseline dimension
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Dimensions

Dimension Types (continued)

• Angular dimensions: use dimang command

• Insert Center Mark: use dimcenter command

• Dimension circle diameter: use dimdia command

• Dimension circle radius: use dimrad command

Angular Dimensions

Diameter dimension Radial dimension

Center mark
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Dimensions

Automated Hatching

• BHATCH (Boundary Hatch): Automatically hatches 
based on the nearest boundary to the specified points

• Access BHATCH by
• Typing bh on the command line
• Selecting Hatch from the Draw menu
• Selecting the Hatch tool from the Draw toolbar

• Tabbed pages of Boundary Hatch dialog box allow…
• Choice of predefined or user-defined hatch patterns
• Hatch boundaries to be determined by picking objects
• Hatch boundaries to be determined by picking points 

on the interior of a boundary
• Disposition of interior “islands”
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Wire Frame and Surface Models

Creating and Viewing 3D Objects

• UCS: User Coordinate system
• World Coordinate System

• AutoCAD’s absolute coordinate system
• All other UCS’s are defined with respect to the WCS
• WCS is indicated by a W in the UCS icon

• WCS icon corresponds to (0,0,0) in 3D space
• Z-Axis is indicated here as positive perpendicular to 

the screen (2D view)
• Viewpoint

• The point from which you are viewing the objects 
within AutoCAD. Access via the Named Views tool 
from the Standard Toolbar

• Example: Southeast Isometric viewpoint
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Wire Frame and Surface Models

Creating and Viewing 3D Objects (continued)

• Coordinate system icons indicate current viewpoint

• New UCS can be defined by choosing New UCS, 
Origin from the Tools menu

• Same menu can be used to switch among various 
stored user coordinate systems
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Wire Frame and Surface Models

Creating and Viewing 3D Objects (continued)

• Pointing devices (left mouse button, etc.) cannot be 
used to enter 3D point locations.  Methods of 
pointing are limited to either

• Typing 3D coordinates from keyboard
• Using X/Y/Z point filters
• Snapping to objects 

• Viewport mode
• Allows the simultaneous display of up to four different 

views 
• Any work done in one view will be reflected in all 

others
• Views defined in dialog box by choosing Viewports, 

New Viewports from the View menu
• Note that viewport arrangement is shown 

schematically in the Preview Pane
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Wire Frame and Surface Models

Wire Frame versus Surface Models

• Wire Frame Model: Model consists of only the points 
and lines connecting the points

• The surfaces of the object “do not exist” within 
AutoCAD unless they are specifically defined

• Triangular and quadrilateral faces may be defined 
using the 3DFACE command 

• Invoke command by choosing Surfaces, 3D Face from 
the Draw menu

• Enter points P1, P2, P3, P4 in order as indicated on 
the above diagram  (counterclockwise)

• Points can be typed on the command line, or can be 
picked in any view port

• Hidden Lines
• Lines that would not be seen when “hidden” behind 

solid surfaces
• In the above surface model, the “thin” lines are hidden, 

while the thick lines are visible

P1 P2

P3P4
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Wire Frame and Surface Models

Wire Frame versus Surface Models (continued)

• Hidden lines can be temporarily removed from 
specific views by using the HIDE command 

• Hidden lines are returned to view whenever the 
screen is regenerated

• Type hi on the command line, or choose View, Hide
from the menu bar to access the hide command

• Hidden line removal has no effect on wire frame 
models (because there are no surfaces present to 
block the view of any lines)

• This command may act strangely if all of your layers 
are not on and unfrozen:

• Frozen layers are ignored by the Hide command
• Layers that are off are treated like visible layers, but 

are not displayed.  Surfaces that have been created 
on a layer that is not turned on can therefore “hide” 
lines that are on a visible layer.

• Example of hidden line removal (Two viewports):
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Wire Frame and Surface Models

Other Surface Generation Techniques

• TABSURF (tabulated surface) requires…
• Line or curve to define the shape of the surface
• Vector to show surface size (length) and direction
• Surface is generated by repeating the shape of the 

original curve at every point along the path specified 
by the vector

• Two viewport example is shown below (note that 
curve and surface is contained within the XY plane)

• RULESURF
• Allows a surface to be generated between two 

different paths
• Example below shows surface generated between the 

line and the curve shown to the above left
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Wire Frame and Surface Models

Other Surface Generation Techniques (continued)

• EDGESURF  
• Generates a surface bounded by four curves
• Restriction is that the four edges must create a 

bounded surface – they must enclose a flat or curved 
area

• Example of curves and surface formed using 
EDGESURF command

• REVSURF
• Creates surfaces by spinning a curve through a given 

angle around an axis of revolution
• Surfaces always follow an arc-shaped path – they 

generate fully three-dimensional surfaces!
• Example below shows surface generated using the 

figure shown to the above left
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Wire Frame and Surface Models

Introduction to Solid Modeling

• Complex 3D objects are created by combining or 
subtracting basic solid shapes

• The basic solid shapes used are known as primitives and 
are found on the Solids toolbar

• Solids are created from the primitives using the three basic 
Boolean operators found on the Solids Editing toolbar

• Example:  Washer created from the subtraction of two 
cylinders
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Plotting (Chapter 2)

Simple Method for Plotting

• In AutoCAD 2000, generating a hardcopy of your drawing 
is referred to as plotting, regardless of whether a printer or 
a plotter is used

• Simplest method: directly plot from current model space to 
paper

• Type Ctrl-P, select the Plot tool from the standard toolbar, 
or select Plot… from the pull down menu to view Plot 
dialog box

• Plot Settings Tab: Contains options which determine how 
the drawing will appear on paper when plotted
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Plotting (Chapter 2)

Plot Window

• Dialog box option; simplest method of defining an 
area to be printed or plotted

• In the Plot Settings Dialog Box, click
• Use the mouse to define the plot window as shown:

• Make sure that Scaled to Fit is visible in the Plot 
Scale area of the dialog box, so that the object fits 
correctly on the paper when plotted

Corner 1

Corner 2
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Plotting (Chapter 3)

Plot Preview

• Allows drawings to be previewed before they are 
plotted on paper

• Plot Preview is found under the Plot Device tab of 
the Plot dialog box

• Partial Preview shows an outline of the effective 
plotting area in relation to the printable area, as well 
as a triangular origin icon

• Full Preview shows an image of the drawing in relation 
to its actual position on the paper 

• Choose OK to print if drawing placement looks 
satisfactory
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Plotting (Chapter 4)

Plot Device

• Add a Plotter Wizard
• Installs a plotter driver
• Accessed by choosing Plotter Manager from the Files

menu
• If no plotter is available, choose the DWF ePlot utility, 

which simulates the behavior of a plotter
• Plot Styles

• Accessed under the Plot Device tab of the Plot dialog
• Allows a drawing to be plotted differently from how it 

appears on the screen
• What to Plot

• Accessed under the Plot Device tab of the Plot dialog
• Allows you to choose among the various model and 

layout views that comprise your AutoCAD drawing
• Plot to File

• Accessed under the Plot Device tab of the Plot dialog
• Creates a plot file that allows the drawing to be plotted at 

a later time or at another site
• Plot file has the same name as the AutoCAD drawing, 

with a .plt extension
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Plotting (Chapter 4)

Plot Settings

• Drawing Orientation
• Accessed under the Plot Settings tab of the Plot dialog
• Portrait: paper is oriented with the short edge parallel 

to the horizontal direction
• Landscape: paper is oriented with the long edge 

parallel to the horizontal direction
• Default mode is generally set to landscape, which 

corresponds to how a drawing is depicted on the 
screen

• Plot Area
• Accessed under the Plot Settings tab of the Plot dialog
• Determines what is plotted as compared to what is 

displayed on the screen
• Display: Plots only what is on the screen
• Extents: Plots the entire drawing area
• Limits: Plots the drawing limits specified using the 

LIMITS command
• View: Only active when multiple views are used
• Window: Only active if a plot window has been 

selected, as described in Chapter 2
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Plotting (Chapter 4)

Plot Settings (continued)

• Plot Scale
• Accessed under the Plot Settings tab of the Plot dialog
• Scaled to fit

• Maximizes the size of the drawing when plotted
• No relation between size of objects as depicted and 

actual size
• Specific scales can be chosen by using the scale pull-

down menu, when required
• Plot Offset

• Sets the location of the drawing origin on the plot
• Location of this origin corresponds to the placement of 

the triangular origin icon on the partial plot preview
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Plotting (Chapter 5)

Page Setup

• Allows a group of plot settings to be saved in a file
• Once saved, any desired page setup may be 

recovered and used without manually repeating the 
setup process

• Page setups are accessed and stored via the Plot 
dialog box

• Choose Add to store the current plot settings
• Previously saved setups may be chosen from the 

drop-down list
• Only page setups created for a particular drawing will 

be accessible, though page setups created for other 
drawings may be imported

• Page setups are particular to either model space or 
paper space; layouts created in one will not be visible 
when a plot is begun from the other
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